
 

 

Project Risk Assessment Tool v1.0 
User Guide 

PREPARED BY QUEENSLAND TREASURY CORPORATION  

MAY 2015 



Project Risk Assessment Tool v1.0 User Guide  
 
© Queensland Treasury Corporation 

Page 1

Executive summary 

QTC’s Project Risk Assessment Tool (Tool) is designed to assist Queensland local 

governments with performing a risk assessment on a project. The Tool allows Users to enter 

general information about the project, then specify project options and input the estimated 

budget and contingency (if applicable) for each option. Users can then perform a risk 

assessment on each option. The Tool presents project risks in a: 

� high-level report that compares the risk profile of each option  

� high-level report that summarises the risks for one project option (Feasibility stage only) 

� detailed table that shows the assessment of each risk, and 

� graph that shows the risk profile of each option. 

 

The Tool is designed to be used as part of the Pre-feasibility and Feasibility stages of the 

Project Decision Framework and will assist with: 

� assessing the riskiness of different project options 

� comparing the risk profiles of different project options 

� developing a business case to support an investment decision, and 

� informing the decision-making process of whether to proceed with a project. 
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1 Overview 

The Tool is designed to assist Queensland local governments to perform a risk assessment on 

a project. The Tool creates easy-to-understand reports that enable decision makers to evaluate 

the risk of different project options. The Tool is designed to be used as part of Queensland 

Treasury Corporation’s Project Decision Framework (PDF). 

 

The Tool is organised into three major sections: 

1. Setup (for aligning the Tool with your organisation’s risk management policy) 

2. Pre-Feasibility (for performing a risk assessment at the Pre-feasibility stage) 

3. Feasibility (for performing a risk assessment at the Feasibility stage) 

 

It is important to note that the accuracy of the Tool and its outputs are determined 

significantly by the accuracy and completeness of the information entered by the User. All 

input fields are shaded yellow. The Tool has been password protected to ensure the integrity of 

the Tool is maintained. 

 

The latest version of the Tool and all resources to assist Users with operating it are available on 

QTC Connect. These can be easily accessed via our website (www.qtc.com.au). Login to QTC 

Connect and the suite of resources are located under Tools > Project Risk Assessment Tool. 

 

The sections below outline how to operate the Tool. If you require further assistance with 

using the Tool, please contact your QTC Account Manager. 
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2 Getting started 

The Tool has been developed in Microsoft Excel 2010. We highly recommend that the Tool 

be used in this version of Excel as limitations have been identified when opening the Tool in 

previous versions. QTC does not guarantee that the Tool is backwards compatible. 

 

The Tool is around 2MB in size. The Tool has been saved with the extension ‘.xlsb’ which is a 

more efficient format when working with large files. It helps to reduce the size of the file and 

improve the speed. 

 

The Tool uses a number of Microsoft Excel settings which may not be set by default on your 

system. Follow the steps below to start using the Tool, noting that in most cases the Tool will 

be downloaded from QTC’s website, received via email or on a USB. 

2.1 Using the Tool  

2.1.1 Step 1: Saving the file to your directory 

From QTC Connect 

1. Using your internet browser, navigate to www.qtc.com.au and follow the links on the right 

to login to QTC Connect. If you do not already have a username and password set up for 

QTC Connect, please discuss this with your Account Manager. 

2. Once logged in, select Tools from the top navigation bar. 

 

3. Select Project Risk Assessment Tool from the menu bar on the left. 

4. Click on the button to download the Project Risk Assessment Tool 

5. Navigate to the desired folder and save. 

From an email 

To save the Tool from an email, right mouse click on the attached file included in the email 

and select ‘Save as…’. Then navigate to the desired folder and save. 

From a USB 

To save the Tool from a USB, open the computer drive that contains the USB (it may be 

shown as a ‘removable disk’). Right mouse click on the file saved to the USB and select ‘Copy’. 

Navigate to the desired folder, right mouse click inside the folder and select ‘Paste’.  
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2.1.2 Step 2: Open the file 

Open windows explorer and find the file in the directory where you saved it. Double click on 

the file to open it. 

2.1.3 Step 3: Enable editing and macros 

When you open the file you may see a yellow bar at the top of the screen which includes one 

of the following notifications: ‘This file originated from an Internet location and might be 

unsafe’ or ‘Security Warning Macros have been disabled’. In each respective case, simply click 

on the respective ‘Enable Editing’ or ‘Enable Content’ button provided. This will ensure the 

tool can be used as intended and that macros are enabled. 

 

 
 

 
 

Note: there are different levels of macro security within Microsoft Office products. These 

instructions assume that macro settings have been set to ‘Disable all macros with notification’ 

which is the most common setting. You can view your setting by navigating to File > Options 

> Trust Centre. Click on ‘Trust Centre Settings…’ then ‘Macro Settings’ to view the selection. 
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2.1.4 Step 4: Set all calculations to automatic 

Select File > Options > Formulas > Workbook Calculations and click on ‘Automatic’ in the 

workbook calculation section. 

 

 

2.2 User functions 

There is a number of usability features that assist Users to populate inputs correctly and 

navigate around the Tool. 

2.2.1 Worksheet header 

The header of some worksheets contains hyperlinks that help the User navigate between the 

Definitions sheet, Index sheet and Risk Assessment sheets. To go to the desired sheet, simply 

click the icon. 

 

 

2.2.2 Legend 

A copy of the cell formatting used consistently in the Tool has been reproduced below. 

 

 

 

 

Project Risk Assessment Tool

Legend and risk definitions

Pf-RiskAssessment

F-RiskAssessment

Pf-Index

F-Index
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2.2.3 The index (Pf-Index and F-Index sheets) 

The Pf-Index and F-Index sheets provide an overview of the process involved in inputting the 

correct information and interpreting the reports. Each worksheet lists the tasks required at 

each stage of the risk assessment and provides a hyperlink to the appropriate worksheet. 

 

 
 

These worksheets are designed to be used as a prompt for experienced users of the Tool. First-

time users should follow the process outlined in the following sections of the User Guide. 

INSTRUCTIONS

STAGE HYPERLINK TO SHEET TASK

Inputs Pf-GenInfo Identify the project and describe its purpose including the desired outcome.

Name and describe each project option. Describe the type of asset in each option. Provide an indicative budget of each option.
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3 Methodology 

In a project context, risk can be defined as anything that may cause the actual project outcome 

to differ from the expected project outcome. The degree of uncertainty of outcome depends 

on two factors: the likelihood of the risk occurring and the potential consequences if it did 

occur. Given the capacity of likelihood and potential consequence to capture uncertainty, the 

Tool uses these characteristics to assign a ‘rating’ to each risk.  

 

The Tool uses clear definitions of likelihood and consequence to ensure risks are rated 

consistently across options and projects. This allows Users to compare the risk profiles of 

different options within a project. The likelihood of a risk occurring is classified using a 

probability-based definition, timing-based definition or descriptive definition. The potential 

consequence if the risk did occur is classified using financial consequences, reputational 

consequences, environmental consequences or health and safety consequences. 

 

Risks arise from many different sources. For this reason, similar risks are grouped into one of 

five categories for reporting purposes: technical, economic, commercial, organisational or 

political (see Appendix A: for example categorisation of specific risks). This allows users to 

compare different options according to the spread of risk across categories. 

 

Once option risks have been classified, the Tool gives each option a rating based on its highest 

risk. For example, if an option has three risks (low, moderate and extreme) the option will be 

given the rating of its highest risk (extreme). 

 

The risk assessment at the Pre-feasibility stage should only include key risks. This is because 

the risk assessment should form part of an ‘Options Analysis’, in which a high-level risk 

assessment should be sufficient. The Feasibility stage risk assessment should include all risks 

because this will form part of a ‘Business Case’ that requires a more detailed risk assessment. 

 

Please see the ‘Setup – Definitions sheet’ section to align the risk Tool with your organisation’s 

risk management methodology before using the Tool to perform a risk assessment. 

3.1 Alignment with risk management policies 

This Tool is designed exclusively to assist organisations perform effective risk assessments on 

potential projects. The Tool uses a simple and well-defined framework to classify risks and 

create easy-to-understand reports that decision-makers will find useful.  

 

This Tool is intended to complement your organisation’s risk management policy. At the same 

time, QTC recognises that it is impossible for this Tool to align perfectly with the myriad of 

risk management methodologies that are practised. For this reason, the terminology and 

definitions pre-populated in the Tool should be used as a guide only. Users should align the 

terminology and definitions used in the Tool with their own organisation’s risk management 

policy (where possible). 
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4 Setup – Definitions sheet 

4.1 Risk assessment dashboard 

Before the Tool can be used, it must be configured to align with your Council’s risk 

management definitions and methodology using the steps shown below. All of the cells shaded 

yellow can be adjusted and should be modified to fit within your organisation’s risk 

management strategy. 

 

Step 1: Define consequence terminology and classifications 

The potential consequences of each risk have 

been set by default to range from insignificant 

to catastrophic. However, the Tool will allow 

the User to redefine the consequence 

classifications and definitions to align with 

your Council’s risk management policy.   

 

 

 

Step 2: Define likelihood terminology and classifications 

The likelihood of each risk has been set by 

default to range from rare to almost certain. 

However, the Tool will allow the User to 

redefine likelihood terminology and 

classifications to align with your Council’s risk 

management policy.  
 

Financial consequence Reputational consequence

Some short term damage to reputation

Minor short term damage to reputation

Financial impact of more than 70% of project value

Financial impact of no more than 70% of project value

Damage to reputation is beyond repair

Substantial long-term damage to reputation

Financial impact of no more than 10% of project value

Financial impact of no more than 30% of project value Substantial short to medium term damage to reputation

Financial impact of no more than 1% of project value

Environmental consequence Healtha and safety consequ ence

No environmental harm No injuries

Catastrophic environmental harm Multiple employee/community deaths

Major long-term environmental harm Extensive injuries

Medical treatment required

Minimal long-term environmental harm First aid required

Moderate environmental harm
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Step 3: Define rating terminology 

The rating terminology has been set 

by default to range from extreme to 

low. However, the Tool will allow the 

User to redefine rating terminology to 

align with your Council’s risk 

management policy. Ensure the first 

three letters of each rating are unique 

to the other ratings (eg, ABC is 

different to ACB, but ABC and 

ABCD are the same). Otherwise the 

reports will not be able to 

differentiate between different 

ratings. 

 

 

Step 4: Define rating classification 

The Tool assigns each risk a ‘rating’ based on the likelihood of occurrence and potential 

consequences. The User must use the drop-down boxes in the matrix to determine what rating 

will be assigned to each risk based on its consequence and likelihood.  

 
  

Probability-based definition Timing-based definition

Is likely to occur more than once every year

Is likely to occur once every year

Is likely to occur once every 5 years

Is likely to occur once every 10 years

Is unlikely to occur once in 10 years

No more than 70% chance of occuring

No more than 30% chance of occuring

No more than 10% chance of occuring

No more than 1% chance of occuring

More than 70% chance of occuring

Descriptive definition

Is expected to occur in all circumstances

Will probably occur in most circumstances

Might probably occur at some time

Will probably not occur at any time

May occur only in exceptional circumstances

STEP 4: Determine rating classification

Likelihood classification

Consequence classification Almost certain Likely Possible Unlikely Rare

Catastophic Extreme Extreme High High Moderate

Major Extreme High High Moderate Moderate

Moderate High High Moderate Moderate Low

Minor High Moderate Moderate Low Low

Insignificant Moderate Moderate Low Low Low
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4.2 Example risk categorisation 

The Tool groups similar risks into one of five categories for reporting purposes: technical, 
economic, commercial, organisational or political. A guide to assist users to classify risks into 
one of the categories has been included under the ‘Example risk categorisation’ section of the 
Definitions worksheet. These cells are shaded yellow and can be edited as required. Users can 
categorise risks in accordance with their Council’s risk management policy, by adding or 
reclassifying risks where required. 
 

 

4.3 Example mitigation categories 

Mitigation strategies can be grouped into one of four categories: preventing the risk; 
transferring the risk to another party; mitigating the consequences of the risk; or accepting the 
risk when there is no other alternative. A description of each category is included on the 
Definitions worksheet. These definitions will be important when performing a risk assessment 
and classifying the mitigation strategy assigned to each risk. 
 

 
 
These classifications are reported in the Pf-RiskRegister and F-RiskRegister sheets and will 
help decision-makers assess whether the mitigation strategy applied to each risk is appropriate.  

EXAMPLE RISK CATEGORISATION

Category Underlying risk Low risk Extreme risk

Project location Standard New frontier

Climate Temperate Remote desert

Location Level/open Mountainous

Scope definition Well defined Poorly defined

Existing infrastructure Reliable Non-existent

Project complexity Simple Complex

Technology Conventional New/unproven

Safety Safe Dangerous

Schedule Realistic Unrealistic

Inflation Favourable Unfavourable

Currency Single major Multiple

Economic

Technical

EXAMPLE MITIGATION CATEGORIES

Strategy Description

Risk prevention Adopting measures to eliminate the source of risk or substantially reduce the likelihood of loss from their occurance.

Risk transfer Shifting the risk to another party who bears the consequences if the risk eventuates.

Impact mitigation Adopting measures to minimise the consequence of the risk.

Risk acceptance Occurs when risks cannot be avoided or transferred, or the cost of doing so is prohibitive. Risk mitigation measures should be adopted to minimise impacts, where feasible.
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5 Pre-feasibility inputs and risk assessment 

5.1 General information – Pf-GenInfo sheet 

Step 1: Input general project information 

Enter general information about the project including its name, any identification numbers and 

important contacts. Input the project purpose and any comments relating how the risk 

assessment was conducted (eg, by conducting a risk workshop). 

 

Step 2: Input project options 

Enter specific information about each option including the option name and include a short 

description. 

 

Step 3: Input option budget 

Enter the estimated budget of each option. 

 
 

Step 3: Determine option contingency 

Assign a contingency for each option. The Tool 

allows Users to enter a contingency for each 

individual risk. The ‘Contingency based on risk 

assessment’ column automatically calculates the 

sum of all the contingencies for risks that apply 

to that option (based on the User’s risk 

assessment). The User can also enter an override 

value which will be used as the contingency 

applied for reporting purposes. 

 

5.2 Risk assessment – Pf-RiskAssessment sheet 

Conduct a risk assessment of each option using the steps below. 

STEP 1: Input general project information

Project name Water Treatment Plant

Reference

Project stage Pre-feasibility

Primary contact Aaron Walker

Business Unit Engineering services

Project Sponsor Bill Jenkins

General comments The existing water treatment plant will not be able to cope with demand increases attributable to population growth over the next five years. Action must be taken to ensure the Council 

can service the community's requirements for water and waste water services.

This project is addressing the need to improve water treatment services the Council provides to the community. Council intends to continue to provide good quality water supply at low cost 

to consumers. This is a Net Present Value project, but non-financial issues must also be considered.

Project purpose (incl. 

desired outcome)

STEP 2: Input project options

Option number Name Description

Option 1 Status quo This is the 'do nothing' scenario

Option 2 New building Build a new building

STEP 3: Input option budget

Estimated budget

100,000$                                                        

72,000$                                                          

STEP 4: Determine option contingency

Contingency based 

on risk assessment

Contingency override Contingency 

applied

2,014$                            2,014$               

2,022$                            2,500$                             2,500$               
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Step 1: Identify key risks 

Identify key risks. Describe 

how these risks are caused, 

their likelihood and possible 

effects. Categorise each risk as 

appropriate (a guide to how 

risks may be categorised had 

been placed on the 

‘Definitions’ worksheet).  
 

Step 2: Determine mitigation strategies 

Determine an appropriate mitigation strategy. 

Describe how this strategy will work and classify 

it accordingly. Although the selected strategies 

may fall into more than one category, just select 

the one approach will be more important in 

minimising the risk. 

 
 

Step 3: Determine risk rating 

Determine the likelihood of the risk occurring and the 

consequences if it did occur based on the definitions 

outlined earlier. The Tool will automatically calculate the 

risk rating based on the configuration of the rating 

classification table (see Step 4 of the Definitions 

worksheet). 
 

 

Step 4: Assign contingency 

If applicable, assign an appropriate contingency to each risk. 

 
 

Step 5: Identify the option(s) this risk will apply to 

Select which option(s) each risk will apply to using the drop-down boxes. 

 
 

Error checks 

STEP 1: Identify key risks

Risk Description of cause, likelihood and effects Cat egory

Site conditions Unanticipated adverse ground conditions are 

discovered.

Would potentially cause additional 

construction cost and/or time, though similar 

construction has been undertaken successfully 

nearby without this issue.

Technical

Contractor failure Contractor may fail financially or fail to 

continue to provide services to the required 

specification.

Commercial

STEP 2: Determine mitigation strategies

Mitigation 

strategy

Description of mitigation strategy

Risk transfer Allocate the risk to the construction 

company as it is best placed to manage it 

(e.g. through expert testing and due 

diligence assessments).

Impact mitigation Organisation to carry out due diligence on 

contractors regarding probity and financial 

capacity.

Contingency plans to be put in place for 

alternative delivery of services.

STEP 3: Determine risk rating

Likelihood Consequence Rating

Unlikely Catastophic High

Possible Moderate Moderate

Step 4: Assign contingency

Contingency

2,000$                                                            

4,500$                                                            

STEP 5: Identfiy the option(s) this risk will apply to

Status 
quo

New 
building

Bigger 
building

Biggest 
building

Augment 
current site

Re-open old 
site

Demand 
management

Discontinue 
service

Yes Yes Yes Yes Yes Yes

Yes Yes Yes
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Check that information has been entered correctly. A simple error 

check has been included in the Tool to help Users accurately capture 

information in the risk reports. This cell checks whether the 

likelihood and consequence classification of each risk matches the 

terminology on the Definitions sheet (Step 3 Pf-RiskAssessment 

sheet) and whether the rating classification has been entered 

correctly (Step 4 Definitions sheet).  

 

Adding new rows 

The Tool is set up with plenty of rows in the risk assessment table. If needed, you can add 

more rows to the risk assessment table by clicking the insert rows button at the top of the 

page. The button adds new rows into the second last row on the risk assessment table.  

 

Keep in mind that adding new rows will require the Tool to perform more calculations, 

making it bigger in size and slower to run. It is best to only add new rows when they are 

needed. Importantly, there is no mechanism to delete rows once inserted. 

Once the insert rows button is 

clicked, a small message box will 

appear. Enter the number of rows 

you would like to insert into the Tool 

(only a maximum of 50 is allowed at a 

time) and click ‘OK’. If you have 

accidentally clicked the ‘insert rows’ 

button, simply click ‘Cancel’. 
 

 

Error checks

ERROR: Check likelihood 

and consequence 

classifications in STEP 3 or 

STEP 4 on Definitions sheet
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6 Feasibility inputs and risk assessment 

6.1 General information – F-GenInfo sheet 

Step 1: Input general project information 

Confirm general information about the project including its name, an identification numbers 

and important contacts. The project purpose cell shows what was entered in the Pre-feasibility 

stage. 

 

Step 2: Input project options 

Select the options approved for assessment at the Feasibility stage using the drop-down boxes. 

The options description cells show what was entered in the Pre-feasibility stage. 

 
 

Step3: Determine option budget 

Review the estimated budget for each option 

and adjust as necessary. The budget entered 

at the Pre-feasibility stage is shown, but this 

may need to be adjusted if the estimated 

budget has changed by entering an updated 

budget in the Feasibility budget column. If 

the budget is updated, this will be reflected in 

the Budget applied column and will be shown 

in the risk reports. 

 

 

 

 
  

STEP 1: Input general project information

Pre-feasibility details Business Case details Details shown in reports

Project name Water Treatment Plant Water Treatment Plant

Reference

Project Phase Feasibility Feasibility

Primary contact Aaron Walker Aaron Walker

Business Unit Engineering services Engineering services

Project Sponsor Bill Jenkins Bill Jenkins

General comments

Project purpose (incl. 

desired outcome)

The existing water treatment plant will not be able to cope with demand increases attributable to population growth over the next five years. Action must be taken to ensure the 

Council can service the community's requirements for water and waste water services.

This project is addressing the need to improve water treatment services the Council provides to the community. Council intends to continue to provide good quality water supply at 

low cost to consumers. This is a Net Present Value project, but non-financial issues must also be considered.

STEP 2: Select project options

Option number Name Description

Option 1 Status quo

Option 2 Re-open old site

Option 3 Bigger building

This is the 'do nothing' scenario

Re-open an old site that is currently unused

Build a bigger building

STEP 3: Determine option budget

Pre-feasibility budget Feasibility 

budget

Budget 

applied

100,000$                             100,000$         

20,000$                               20,000$            

STEP 3: Determine option budget

Pre-feasibility budget Feasibility 

budget

Budget 

applied

100,000$                             120,000$            120,000$         

20,000$                               20,000$            
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Step 4: Determine option contingency 

Assign a contingency for each option. The Tool 

allows users to enter a contingency for each 

individual risk. The ‘Contingency based on risk 

assessment’ column automatically calculates the 

sum of all the contingencies for risks that apply to 

that option (based on the User’s risk assessment). 

The User can also enter an override value which 

will be used as the applied contingency. 

 

Step 5: Import the risk assessment data from the Pre-Feasibility stage 

Once the correct options have been selected, import the risk assessment data entered at the 

Pre-feasibility stage using the button at the top of the page. In this way, the risk assessment 

completed at the Feasibility stage can build upon the assessment at the Pre-feasibility stage. 

 

6.2 Risk assessment – F-RiskAssessment sheet 

Conduct a risk assessment of each option using the five steps below.  

 

Step 1: Identify all risks 

Identify all risks. Describe 

how these risks are caused, 

their likelihood and possible 

affects. Categorise each risk as 

appropriate (a guide to how 

risks may be categorised had 

been placed on the 

‘Definitions’ worksheet). 

 
 

Step 2: Determine mitigation strategies 

STEP 4: Determine option contingency

Contingency based 

on risk assessment

Contingency override Contingency 

applied

2,014$                            2,014$               

2,022$                            2,500$                             2,500$               

STEP 1: Identify all risks

Risk Description of cause, likelihood and effects Cat egory

Site conditions Unanticipated adverse ground conditions are 

discovered.

Would potentially cause additional construction 

cost and/or time, though similar construction has 

been undertaken successfully nearby without 

this issue.

Technical

Contractor failure Contractor may fail financially or fail to continue 

to provide services to the required specification.

Failure may result in distruption to government 

services.

High likelihood, as no contractor has had any 

previous experience in providing construction 

services.

Commercial
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Determine an appropriate mitigation strategy. 

Describe how this strategy will work and classify 

it appropriately (a guide to how mitigation 

strategies may be categorised had been placed on 

the ‘Definitions’ worksheet). Although the 

selected strategies may fall into more than one 

category, just select the one approach will be 

more important in minimising the risk. 

 
 

Step 3: Determine risk rating 

Determine the likelihood of the risk occurring and the 

consequences if it did occur based on the definitions 

outlined earlier. The Tool will automatically calculate 

the risk rating based on the configuration of the rating 

classification table (see Step 4 of the Definitions 

worksheet).  

 

Step 4: Assign contingency 

If applicable, assign an appropriate contingency to each risk. 

 
 

Step 5: Identify the option(s) this risk will apply to 

Select which option(s) each risk will apply to using the drop-down boxes. 

 
 

Error checks 

Check that information has been entered correctly. A simple error 

check has been included in the Tool to help Users accurately capture 

information in the risk reports. This cell checks whether the 

likelihood and consequence classification of each risk matches the 

terminology on the Definitions sheet (Step 3 F-RiskAssessment 

sheet) and whether the rating classification has been entered 

correctly (Step 4 Definitions sheet).  

 

Adding new rows 

STEP 2: Determine mitigation strategies

Mitigation 

strategy

Description of mitigation strategy

Risk transfer Allocate the risk to the construction 

company as it is best placed to manage it 

(e.g. through expert testing and due 

diligence assessments).

Impact mitigation Organisation to carry out due diligence on 

contractors regarding probity and financial 

capacity.

Contingency plans to be put in place for 

alternative delivery of services.

STEP 3: Determine risk rating

Likelihood Consequence Rating

Unlikely Catastophic High

Possible Moderate Moderate

Step 4: Assign contingency

Contingency

2,000$                                                            

4,500$                                                            

STEP 5: Identfiy the option(s) this risk will apply to

Status quo Re-open old site Bigger building Discontinu e service

Yes Yes

Yes

Error checks

ERROR: Check likelihood 

and consequence 

classifications in STEP 3 or 

STEP 4 on Definitions sheet
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The Tool is set up with plenty of rows in the risk assessment table. If needed, you can add 

more rows to the risk assessment table by clicking the insert rows button at the top of the 

page. The button adds new rows into the second last row on the risk assessment table.  

 

Keep in mind that adding new rows will require the Tool to perform more calculations, 

making it bigger in size and slower to run. It is best to only add new rows when they are 

needed. Importantly, there is no mechanism to delete rows once inserted. 

 

Once the insert rows button is 

clicked, a small message box will 

appear. Enter the number of rows 

you would like to insert into the Tool 

(only a maximum of 50 is allowed at a 

time) and click ‘OK’. If you have 

accidentally clicked the ‘insert rows’ 

button, simply click ‘Cancel’. 
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7 Outputs 

The Tool presents three risk reports for the Pre-feasibility assessment and four risk reports for 

the Feasibility assessment. Each report is described below. 

7.1 Options comparison and option summary reports 

Option Comparison (Pf-OptionComparison and 
F-OptionComparison sheets) 

Option Summary—Feasibility stage only (F-
Summary sheet) 

This report shows general project information, 

the number of risks by rating, the maximum 

risk for each category and the biggest risks for 

each option. It is designed for comparing the 

risk profile of different options. 

This report shows information for a single 

option, which can be selected using the drop 

down box. The report shows general project 

information, the number of risks in each 

category and the biggest risks for that option. 

 

  

Water Treatment Plant option risk comparison report
General Information

Primary Contact Aaron Walker Sponsor Bill Jenkins

Business unit Engineering services Current phase Feasibility

Project purpose

Comments

Number of risks for each risk rating

Maximum risk of each category

Extreme

High

Moderate

Low

Biggest risks for each option

Ext Foreign exchange Ext Contractor issues Ext Contractor issues Hig Reputation

Mod Interest rates Hig Reputation Ext Foreign exchange Mod Interest rates

Mod Liquidity Low Team Hig Reputation Low Team

Low Team Mod Interest rates Low Team skills

Low Team skills Mod Contractor failure Low Team spirit

Low Team spirit Low Team

Low Site conditions Low Team skills

Low Employee turnover

Low Site conditions

This project is addressing the need to improve water treatment services the Council provides to the 

community. Council intends to continue to provide good quality water supply at low cost to consumers. This 

is a Net Present Cost project so non-financial issues must also be considered.

The existing water treatment plant will not be able to cope with demand increases attributable to population 

growth over the next five years. Action must be taken to ensure the Council can service the community's 

requirements for water and waste water services.

Status quo Re-open old site Bigger building Discontinue service
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Extreme High Moderate Low Budget applied Budget + Contingency

Status quo Re-open old site Bigger building Discontinue service

Technical Economic Commercial

Water Treatment Plant risk summary report
General Information

Option name Primary Contact Aaron Walker

Option number Option 3 Business unit Engineering services

Current phase Feasibility Sponsor Bill Jenkins

Project Budget $100,000.00 Project Contingency $10,000.00 10% of budget

Project purpose

Comments

Number of risks in each category Risk rating of biggest risk: Extreme

Biggest risks for this option
Risk Description Mitigation strategy Contingency

E
xt

Contractor issues  $   2,575.60 

E
x

t

Cost inflation  $      185.82 

H
ig

Reputation  $   5,841.62 

M
o

d

Interest rates  $   4,703.35 

M
o

d

Contractor failure  $               -  

L
o

w

Team  $   5,976.07 

L
o

w

Team skills  $   4,513.51 Description of cause, likelihood and 

effects

Details of mitigation strategy

Description of cause, likelihood and 

effects

Details of mitigation strategy

Description of cause, likelihood and 

effects

Details of mitigation strategy

Description of cause, likelihood and 

effects

Details of mitigation strategy

Description of cause, likelihood and 

effects

Description of cause, likelihood and 

effects

Details of mitigation strategy

Description of cause, likelihood and 

effects

Details of mitigation strategy

Details of mitigation strategy

Bigger building

This project is addressing the need to improve water treatment services the Council provides to the 

community. Council intends to continue to provide good quality water supply at low cost to consumers. This is 

a Net Present Value project, but non-financial issues must also be considered.

The existing water treatment plant will not be able to cope with demand increases attributable to population 

growth over the next five years. Action must be taken to ensure the Council can service the community's 

requirements for water and waste water services.
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7.2 Risk register (Pf-RiskRegister and F-RiskRegister sheets) 

The Risk Register presents the risk information for one option in a table (this is the risk 

register for that option). This is useful for filtering the risks by category and rating. When a 

new risk is added to the either the Pf-RiskAssessment or F-RiskAssessment sheet the ‘refresh 

chart’ button at the top of the page must be pressed in order to refresh the respective table and 

show the new risk.  

 

7.3 Risk profile (Pf-RiskProfile and F-RiskProfile sheets) 

This report shows the risk profile for a single 

option. This report lists the name and the 

rating of every risk for that option. The report 

can be filtered to show risks that are classified 

with a certain rating or category using the grey 

icons above the chart. 

 

When a new risk is added to the either the Pf-

RiskAssessment or F-RiskAssessment sheet the 

‘refresh chart’ button at the top of the page 

must be pressed in order to refresh the 

respective graph and show the new risk. 
 

 

Note: Updating pivot tables 

When the ‘refresh table’ button is selected to update the pivot tables in the reports above, a 

message box similar to this one may appear: 

 

 
 

If this occurs, simply click ‘yes’ button on the message to update the pivot table. Clicking ‘no’ 

will prevent the pivot table from updating.  
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Disclaimer  

Queensland Treasury Corporation (QTC) has prepared the Project Risk Assessment Tool 

(Tool) for use solely by Queensland local governments (the User) to assist in the consolidation, 

presentation and analysis of key risk metrics associated with projects as they progress through 

each of the Project Decision Framework stages. The Tool should not be used for any other 

purpose. 

 

As use of the Tool is intended for Queensland local governments only, it should not to be 

provided or disclosed to, nor relied upon by, any other party without QTC’s express written 

consent. 

 

The accuracy of the Tool and its outputs is significantly determined by the accuracy, currency, 

completeness and applicability of the information entered by the User. It is also determined by 

the User's understanding of the Tool’s underlying methodology and its appropriateness to the 

User's business. QTC is not in a position to review and verify the suitability of the Tool or its 

inputs to specific situations being examined by the User and, therefore, QTC accepts no 

responsibility for the incorrect application of the Tool by the User or the entry of incorrect 

information into the Tool. 

 

The outputs of the Tool should be used as a guide only. Specific advice should be obtained 

before acting on the basis of any output of the Tool.  

 

Neither QTC nor any of its employees or agents accepts any liability for any loss or damage 

suffered by any person as a result of that person or any other person placing any reliance on, 

or acting on the basis of, the contents of the Tool or the financial statements and reports 

generated by the Tool. To the extent permitted by law, QTC expressly excludes any 

representation or warranty in relation to the accuracy, currency and completeness of the Tool. 

To the extent permitted by law, by using the Tool you agree that any QTC liability in 

connection with the Tool will be limited to the amount of fees received by QTC in relation to 

the Tool. 

 

QTC does not provide legal, tax or accounting advice. Such advice should be sought from an 

independent expert practitioner before applying the information contained in the Tool. 

 

© Queensland Treasury Corporation 
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Appendix A:  Example risk categorisation 

In Table 1 below, different types of risk have been categorised into one of the five categories: 

technical, economic, commercial, organisational and political. This is not intended to be an 

exhaustive or definitive list. Instead, these are just examples of the types of risk that may be 

classified into one of these categories. This table is also shown on the Definitions sheet in the 

Tool. 

 
TABLE 1: EXAMPLE RISK CATEGORISATION 

Category Underlying risk Low risk Extreme risk 

Technical Project location Standard New frontier 

Climate Temperate Remote desert 

Location Level/open Mountainous 

Scope definition Well defined Poorly defined 

Existing infrastructure Reliable Non-existent 

Project complexity Simple Complex 

Technology Conventional New/unproven 

Safety Safe Dangerous 

Economic Schedule Realistic Unrealistic 

Inflation Favourable Unfavourable 

Currency Single major Multiple 

Commercial Operations Group JV/inexperience 

Contract strategy Optimum Undefined 

Contractor competition Multiple bidders Single source 

Contractual interfaces Single contractor Many contractors 

Risk ownership Clear and appropriate Unclear and inappropriate 

Local content requirement None High 

Organisational Cross business Single business units Multiple business units 

No. of locations Single Multi 

Project team competence Good Poor 

Political Government involvement Passive Active 

JV involvement Passive Active 

Environmental issues None Major 

Community issues None Many 

Industrial relations Good Poor 

Reputational issues Standard High profile 

 


